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				Introduction

				Photoshop Elements is now in its 9th version. The product has matured as a tool for both professional and amateur photographers who want to edit, improve, manage, manipulate, and organize photos and other media. Considering the power of the program and impressive features, Elements remains one of the best values for your money among computer software applications. 

				A wave of new hardware devices has hit the shelves this year (no doubt, with more to come in the next few years). The handhelds and iDevices provide their users many different alternatives for showing off photos, and Photoshop Elements 9 is up to the task of tossing your images into the cloud and displaying them on the latest gadgets. From touch screen support to iPhone connectivity, Photoshop Elements stays current with the times.

				Why should you buy Photoshop Elements (and, ultimately, this book)? The range of people who can benefit from using Elements is wide and includes a vast audience. From beginning image editors to intermediate users to more advanced amateurs and professionals, Elements has something for everyone. We’ll even stick our necks out a little and suggest that many Photoshop users can benefit greatly by adding Elements to their software tool cabinets. Why? Because Elements offers some wonderful creation and sharing tools that Photoshop hasn’t yet dreamed of supporting. For example, in Photoshop Elements 9, you can create postcards, greeting cards, and photo albums with just a few mouse clicks. You can place orders with online service centers that professionally print your photo creations. 

				To set your frame of mind to thinking in Photoshop Elements terms, don’t think of the program as a scaled-down version of Adobe Photoshop; those days are gone. Consider the following:

				If you’re a digital photographer and you shoot your pictures in JPEG or Camera Raw format, Elements has the tools for you to open, edit, and massage your pictures into professional images. 

				If you worry about color profile embedding, Elements can handle the task for you, as we explain in Chapter 4, where we talk about Camera Raw, and in Chapter 14, where we talk about color profiling and printing. For the professional, Photoshop Elements has almost everything you need to create final images for color printing and commercial printing.

				If you’re interested in displaying photos on online services or handheld devices, you’re in the right spot. We cover everything from copying and pasting Facebook images to connecting to an iPhone or iPad. Look over Chapters 4, 5, and 16 to find out more.

				If you’re a beginner or an intermediate user, you’ll find that some of the Photoshop Elements quick-fix operations are a breeze to use for enhancing your images, as we explain in Chapters 9 and 10. 

				If you like to print homemade greeting cards and photo albums — whether you’re a beginner, an intermediate user, or a professional user — Elements provides you with easy-to-follow steps to package your creations, as we discuss in Chapters 15 and 16. In addition, the wonderful sharing services available are your gateway to keeping family, friends, and clients connected to your photos, as we explain in Chapter 16.

				About This Book

				This book is an effort to provide, in about 400 pages, as much of a comprehensive view of a wildly feature-rich program as we can. Additionally, this book is written for a cross-platform audience. If you’re a Macintosh user, you’ll find all you need to work on Elements 9 for the Macintosh including the new support for the Organizer on the Mac. 

				There’s a lot to Elements, and we try to offer you as much as possible within a limited amount of space. We begged for more pages, but alas, our publisher wants to get this book in your hands in full color and with an attractive price tag. Therefore, even though we may skip over a few little things, all you need to know about using Photoshop Elements for designing images for print, sharing, Web hosting, versatile packaging, e-mailing, and more is covered in the pages ahead. If you still crave more, take a look at our Adobe Photoshop Elements 9 All-in-One For Dummies (Wiley Publishing), where you can find more comprehensive coverage of Photoshop Elements 9.

				As we said, Photoshop Elements has something for just about everyone. Hence, we know that our audience is large and that not everyone will use every tool, command, or method described in this book. Therefore, we added a lot of cross-references in the text, in case you want to jump around. You can go to just about any chapter and start reading; and, if some concept needs more explanation, we point you in the right direction for getting some background when it’s necessary.

				Conventions Used in This Book

				Throughout this book, we point you to menus where commands are accessed frequently. A couple of things to remember are the references for where to go when we detail steps in a procedure. For accessing a menu command, you may see a sentence like this one:

				Choose FileGet PhotosFrom Files and Folders.

				When you see commands like this one, we’re asking you to click the File menu to open the drop-down menu, click the menu command labeled Get Photos, and then choose the command From Files and Folders from the submenu that appears.

				Another convention we use refers to context menus. A context menu jumps up at your cursor position and shows you a menu similar to the menu you select at the top of the Elements workspace. To open a context menu, right-click the mouse (Control-click on the Mac if you don’t have a two-button mouse).

				A third item relates to using keystrokes on your keyboard. When we mention that some keys need to be pressed on your keyboard, the text is described like this:

				Press Alt+Shift+Ctrl+S (Option+Shift+Ô+S on the Macintosh).

				In this case, you hold down the Alt key on Windows or the Option key on the Macintosh, the Shift key, and the Control key on Windows or the Ô key on the Macintosh, and then press the S key. Then, release all the keys at the same time.

				How This Book Is Organized

				This book is divided into logical parts where related features are nested together in chapters within six different parts of the book.

				Part I: Getting Started

				If you just bought a digital camera and you’re new to image editing in a program such as Photoshop Elements, you’re probably tempted to jump into fixing and editing your pictures. The essentials usually aren’t the most exciting part of any program or book. That’s true with this book, too: The more mundane issues related to understanding some basics are assembled in the first three chapters. Although some bits of information aren’t as exciting as in many other chapters, you must understand them before you start editing images. Be sure to review the first three chapters before you dive into the other chapters.

				In Part I, we talk about the tools, menus, commands, preferences, workspaces, and features that help you move around easily in the program. The more you pick up in the preliminary chapters, the more easily you can adapt to the Elements way of working.

				Part II: Getting Organized

				In Part II, we talk about getting photos in Elements, organizing your files, searching for files, and grouping your photos, and we give you much more information related to the Photoshop Elements Organizer. The Organizer is your central workplace for both Windows and Macintosh users, and knowing a great deal about using the Organizer window helps you move around much faster in the program.

				Part III: Selecting and Correcting Photos

				Part III relates to creating and manipulating selections. There’s a lot to making selections in photos, but after you figure it out (by reading Chapter 7), you can cut out a figure in a picture and drop it into another picture, drop different backgrounds into pictures, or isolate an area that needs some brightness and contrast adjustment. In Chapter 8, we talk about layers and how to create and manage them in Elements. In many other chapters, we refer you to Chapter 8 because you need to work with layers for many other tasks you do in Elements.

				In Chapter 9, we talk about fixing image flaws and problems. That picture you took with your digital camera may be underexposed or overexposed, or it may need some work to remove dust and scratches. Maybe it needs a little sharpening, or another imperfection requires editing. All the know-how and how-tos are in this chapter.

				In Chapter 10, we cover how to correct color problems, brightness, and contrast. We show you ways to quickly fix photos, as well as some methods for custom image corrections.

				Part IV: Exploring Your Inner Artist

				This part is designed to bring out the artist in you. Considering the easy application of Elements filter effects, you can turn a photo image into a drawing or apply a huge number of different effects to change the look of your image.

				In Chapter 12, we talk about drawing and painting so that you can let your artistic expression run wild. We follow up in Chapter 13 by talking about adding text to photos so that you can create your own layouts, posters, cards, and more.

				Part V: Printing, Creating, and Sharing

				You may find yourself printing fewer photos than ever with all the online opportunities and the display devices available to you. However, when it comes time to print a photo, we provide you information on how to produce good color on your desktop color printer in Chapter 14.

				If screen viewing is of interest to you, we cover a number of different options for viewing your pictures onscreen in Chapter 15. For slide shows, Web-hosted images, animated images, photo viewing on your TV, and even creating movie files, this chapter shows you the many ways you can view your Elements images onscreen.

				We wrap up this part with Chapter 16, in which we describe how to make creations and share files by using various online services. You have a number of different options for making creations to share or print.

				Part VI: The Part of Tens

				The last part of the book contains the Part of Tens chapters. We offer ten tips for composing better images and give you ten more project ideas to try with Elements.

				Icons Used in This Book

				In the margins throughout this book, you see icons indicating that something important is stated in the respective text.

				[image: newfeature_9__4c.eps] This icon informs you that the item discussed is a new feature in Photoshop Elements 9.

				[image: tip_4c.eps] A Tip tells you about an alternative method for a procedure, by giving you a shortcut, a workaround, or some other type of helpful information related to working on tasks in the section being discussed.

				[image: warning_4c.eps] Pay particular attention when you see the Warning icon. This icon indicates possible side-effects you might encounter when performing certain operations in Elements.

				[image: remember_4c.eps] This icon is a heads-up for something you may want to commit to memory. Usually, it tells you about a shortcut for a repetitive task, where remembering a procedure can save you time.

				[image: technicalstuff_4c.eps] Elements is a computer program, after all. No matter how hard we try to simplify our explanation of features, we can’t entirely avoid the technical information. If we think that a topic is on the technical side, we use this icon to alert you that we’re moving into a complex subject. You won’t see many of these icons in the book because we try our best to give you the details in nontechnical terms.

				Where to Go from Here

				As we say earlier in this Introduction, the first part of this book serves as a foundation for all the other chapters. Try to spend a little time reading through the three chapters in Part I. After that, feel free to jump around and pay special attention to the cross-referenced chapters, in case you get stuck on a concept.

				When you need a little extra help, refer to Chapter 1, where we talk about using the online help documents available in Elements.

				If you have questions, comments, suggestions, or complaints, go to

				http://support.wiley.com

				We hope you have much success and enjoyment in using Adobe Photoshop Elements 9, and it’s our sincere wish that the pages ahead provide you with an informative and helpful view of the program.

				Please note that some special symbols used in this ePub may not display properly on all eReader devices. If you have trouble determining any symbol, please call Wiley Product Technical Support at 800-762-2974. Outside of the United States, please call 317-572-3993.  You can also contact Wiley Product Technical Support at www.wiley.com/techsupport.
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				In this part . . .

				Here you have it: a computer book specifically designed to help you get the most out of a computer software program — and not just any software program, but a powerful one with many complicated features. You probably want to jump in and perform some spiffy editing operations to get that prize photo looking the best you can. Inasmuch as we try to accommodate you in setting forth a how-to book in a nonlinear fashion, where you can freely move around and read about the techniques you want to use without having to read each chapter in order, you have to understand a few basics for editing your photos.

				In this first part of the book, we talk about essentials to help you fully understand all the parts ahead. We first talk about your Photoshop Elements working environment and describe the many tools and features you can use for all your Elements sessions. We also cover the very important task of getting color set for optimum viewing on your computer monitor and explain what you need to know about color as it relates to photo images. Part I contains some important information that you should plan to carefully review and understand before going too far into all the Elements features. Don’t pass up this part. Turn the page and start getting acquainted with the Adobe Photoshop Elements basics.
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				Chapter 1

				Getting to Know the Work Area

				In This Chapter

				Opening Photoshop Elements

				Understanding the Elements workspace

				Changing workspace views

				Working with the Project Bin

				Using Options menus

				Using the Undo History panel

				Accessing Help documents

				Using keyboard shortcuts

				
				When you first launch Photoshop Elements, you arrive at a Welcome screen. The Welcome screen offers to open different editing modes and to help you start special Elements tasks.

				When it comes to editing a photograph, you find quite a collection of tools, panels, buttons, and options in the Photoshop Elements Edit mode. Just a quick glance at the Elements workspace when you enter Edit Full mode shows you some of the power that Elements offers with just a click of your mouse button. With all the possibilities, navigating the Elements workspaces and engaging in an editing session can be intimidating. To ease your introduction to the many options for editing your pictures, we break them down for you in this chapter.

				Elements has several work areas, and we start off by introducing you to the Welcome screen. Then, we move on to the mode you’ll likely use frequently: Edit Full mode. In this mode, you can be creative with all the tools and features Photoshop Elements is known for, such as filters, drawing tools, layers, and more. We then introduce other work areas and tools you may not be as familiar with: Edit Quick mode for making common corrections to photos; Creation mode for collecting your photos into creations, such as calendars; and the Project Bin for navigating among all your open images.

				Before you start working in Elements, you may find it helpful to know how to undo edits so that you can start over easily and find additional sources of help within Elements. We also explain one of the handiest ways to select tools and enter common commands: keyboard shortcuts.

				Elements also has the Organizer (now available to both Windows and Macintosh users), a powerful tool for acquiring your images and keeping them organized. The Organizer includes features that help you view and search for images, too. We introduce the Organizer in Part II.

				Launching Photoshop Elements 9

				A great place to start in Elements is a central navigation area, where you can choose what mode and activity you want to engage in. Well, that’s exactly what Adobe provides you when you open Photoshop Elements. It’s like the command center on the Starship Enterprise, except you won’t find Spock asking the computer any questions. The Welcome screen is easy to navigate and intuitive, as you can see in Figure 1-1.

				[image: 878729-fg0101.tif]
				Figure 1-1: The Photoshop Elements Welcome screen (Windows) appears when you launch Elements.

				Here’s what you find on the Welcome screen:

				Organize: Click the Organize button to open the Organizer, where you can manage your collections of pictures stored on your hard drive. We cover using the Organizer and many of its great features in Part II.

				Edit: If you need to edit a photo, click the Edit button to access options for using either the Quick Fix mode to do some quick editing tasks or Edit Full mode, in which you can do the extraordinary editing jobs.

				Learn More (Windows): Click the Learn More button to get help information from Adobe’s Web site.

				If you know what you want to do in Elements, go ahead and click the appropriate button. But if you enter one mode and then decide you want to do something in another mode, Elements provides you the freedom to easily change modes from within the different workspaces.

				[image: remember_4c.eps] You can always return to the Welcome screen after you enter any editing mode. At the top of the Elements window in all modes, a house icon appears, as shown in Figure 1-2. Click this icon to open the Welcome screen again.

				[image: 878729-fg0102.eps]
				Figure 1-2: Click the house icon on the menu bar in any editing mode to reopen the Welcome screen.

				Getting Around in Edit Full Mode

				Edit Full mode offers bundles of tools that you can use to edit your images, from correction tools for fixing color and clarity to filters, layers, and more for changing existing photos or creating entirely original images from scratch. But all these tools also make Edit Full mode complex.

				Figure 1-3 shows Elements in Edit Full mode, highlighting all the tools and features we discuss in the following sections.

				Jumping to Edit Full mode

				You can move into Edit Full mode in a couple of ways:

				From the initial Welcome screen: Click Edit and open a photo. Your Elements window appears in Edit Full mode, as shown in Figure 1-3.

				From the Organizer: Click a photo and choose Edit Photos from the Fix drop-down menu. The selected file opens in Edit Full mode.

				[image: tip_4c.eps] You can also open a contextual menu on a photo in the Organizer (right-click to make this menu appear) and choose Edit with Photoshop Elements from the menu.

				[image: 878729-fg0103.eps]

				Figure 1-3: The Photoshop Elements workspace appears when you open a file in Edit Full mode.

				Examining the image window

				Not surprisingly, the image window’s tools and features are most useful when an image is open in the window. To get an image into the image window (as shown in Figure 1-3), follow these steps:

				1. Choose FileOpen.

				 The standard Open dialog box appears. It works like any ordinary Open dialog box you find in other applications.

				2. Move around your hard drive by using methods you know to open folders and then select a picture.

				 If you haven’t yet downloaded digital camera images or acquired scanned photos and want an image to experiment with, you can use an image found in your Pictures folder that was installed with your operating system.

				[image: tip_4c.eps] Elements installs some nice sample images with the application installation. Look in the Photoshop Elements 9\Tutorials folder to find some photos to play with.

				3. After selecting a picture, click Open.

				 The photo opens in a new image window in Elements.

				[image: remember_4c.eps] You can open as many image windows in Elements as your computer memory can handle. When each new file is opened, a thumbnail image is added to the Project Bin at the bottom of the screen. (Refer to Figure 1-3.)

				Notice in Figure 1-3 that filenames appear as tabs above the image window. To bring a photo forward, click the filename. To close a photo, click the X adjacent to the filename.

				Here’s a quick look at important items in the image window, as shown in Figure 1-4:

				[image: 878729-fg0104.eps]
				Figure 1-4: The image window displays an open file within the Elements workspace.

				Filename: Appears above the image window for each file open in the Editor.

				Close button: Click the X to the right of the filename to close the file. (On the Macintosh, click the far-left button.)

				Scroll bars: Become active when you zoom in on an image. You can click the scroll arrows, move the scroll bar, or grab the Hand tool in the Tools panel and drag within the window to move the image.

				Magnification box: Shows you at a glance how much you’ve zoomed in or out.

				Information box: Shows you a readout for a particular tidbit of information. You can choose what information you want to see in this area by selecting one of the options from the pop-up menu, which we discuss in more detail later in this section.

				When you’re working on an image in Elements, you always want to know the physical image size, the image resolution, and the color mode. (These terms are explained in more detail in Chapters 3 and 4.) Regardless of which menu option you select from the status bar, you can get a quick glimpse at these essential stats by clicking the Information box, which displays a pop-up menu like the one shown in Figure 1-5.

				[image: 878729-fg0105.tif]
				Figure 1-5: Click the readout on the status bar, and a pop-up menu shows you important information about your file.

				Size box: Enables you to resize the window. If you move the cursor to the box, a diagonal line with two opposing arrows appears. When the cursor changes, drag in or out to size the window smaller or larger, respectively.

				 You can also resize the window by dragging any corner in or out (Windows).

				When you’re familiar with the overall image window, we want to introduce you to the Information box’s pop-up menu, which enables you to choose the type of information you want to view in the Information box. Click the right-pointing arrow to open the menu, as shown in Figure 1-6.

				[image: 878729-fg0106.tif]
				Figure 1-6: From the pop-up menu on the status bar, choose commands that provide information about your file.

				Here’s the lowdown on the options you find on the pop-up menu:

				Document Sizes: Shows you the saved file size.

				Document Profile: Shows you the color profile used with the file. Understanding color profiles is important when printing files. Look to Chapters 2 and 14 for more information on using color profiles.

				Document Dimensions: When selected (as shown in Figure 1-6), this option shows you the physical size in your default unit of measure, such as inches.

				Scratch Sizes: Displays the amount of memory on your hard drive that’s consumed by all documents open in Elements. For example, 20M/200M indicates that the open documents consume 20 megabytes and that a total of 200 megabytes are available for Elements to edit your images. When you add more content to a file, such as new layers, the first figure grows while the second figure remains static.

				Efficiency: Indicates how many operations you’re performing in RAM, as opposed to using your scratch disk (space on your hard drive). When the number is 100%, you’re working in RAM. When the number drops below 100%, you’re using the scratch disk. If you continually work below 100%, it’s a good indication that you need to buy more RAM to increase your efficiency.

				Timing: Indicates the time it took to complete the last operation.

				Current Tool: Shows the name of the tool selected from the Tools panel.

				[image: remember_4c.eps] Why is this information important? Suppose you have a great photo you want to add to your Facebook account and you examine the photo to find the physical size of 8 x 10 inches at 72 pixels per inch (ppi). You also find the saved file size over 5 MB. At a quick glance, you know you want to resize the photo to perhaps a 4 x 6 inch size and 72 ppi. Changing the resolution dramatically reduces the file size. We cover file sizes and changing the physical dimensions of your photos in Chapter 3. For now, realize that the pop-up menu shows you information that can be helpful when preparing files for print and display.

				Don’t worry about trying to understand all these terms. The important thing to know is that you can visit the pop-up menu and change the items at will during your editing sessions.

				Moving through the menu bar

				Like just about every program you launch, Elements supports drop-down menus. The menus are logically constructed and identified to provide commands for working with your pictures (including many commands that you don’t find supported in tools and on panels). A quick glimpse at the menu names gives you a hint of what might be contained in a given menu list.

				Here are the 10 different menus (11 on a Mac):

				Photoshop Elements (Mac only): On the Macintosh, you find the Photoshop Elements menu preceding the File menu. This menu provides you the Quit command used to exit Elements, and it provides access to Edit Full Preferences, as we explain in Chapter 2.

				File: Just as you might suspect, the File menu contains commands for working with your picture as a file. You find commands on the menu for saving, opening, processing, importing, exporting, and printing. We cover saving files in Chapter 3 and printing or exporting for other output in Part V.

				Edit: The old-fashioned Copy, Cut, and Paste commands are located on this menu. Additionally, you have some important application settings commands on the menu, including Preferences (Windows), which we cover in more detail in Chapter 2.

				Image: You use the Image menu most often when you want to effect changes to the entire image, such as changing a color mode or cropping, rotating, and resizing the image. For details about sizing and color modes, check out Chapter 3. For more about cropping and rotating images, flip to Chapter 9.

				Enhance: Just the name of this menu should tell you what commands to expect here. This is where you go to change the appearance of an image, such as changing its brightness and contrast, adjusting its color and lighting, and doing some other smart fix-up work to improve its appearance. On the EnhanceAdjust Color submenu, you find a number of commands that offer you a variety of color adjustments. Look to Chapter 10 for some detail on correcting color. In Chapters 9 and 10, you can find out how to use correction tools so that your images look their best.

				Layer: As we describe in great detail in Chapter 8 (a whole chapter just about layers), most kinds of editing you do in Elements are best handled by using layers. Elements neatly tucks away most of the relevant commands associated with working in layers right in this menu.

				Select: Of just about equal importance to layers are selections. Whereas the Image menu contains commands that are applied to the entire image, you can edit isolated areas of an image by using the commands on the Select menu. To isolate an area, you need to create a selection, as we explain in Chapter 7. This menu contains commands to help you with many essential tasks related to working with selections.

				Filter: The Filter menu is where you find some professional photographic darkroom techniques, or you can completely leave the world of photography and explore the world of a fine artist. With tons of different filter commands, you can create some extraordinary effects. Find out all about filters in Chapter 11.

				View: Zooming in and out of images, turning on a grid, exposing horizontal and vertical rulers, adding annotations, and checking out the print sizes of your pictures are handled on the View menu. Chapter 5 unearths secrets of the Zoom tool, rulers, and more.

				Window: Elements supports a number of different panels, as we explain in the section “Playing with panels,” later in this chapter. Elements has so many panels that keeping them all open at one time is impractical. Thanks to the Window menu, you can easily view and hide panels, reopen the Welcome window, tile and cascade open windows, and bring inactive windows to the foreground.

				Help: We hope that you get all the help you need right here in this book; but just in case we miss something (or your neighbor has borrowed it, fine book that it is), you have some interactive help right at your mouse-tip on the Help menu. The menu also offers links to the Adobe Web site for more information and a little assistance, courtesy of the tutorials accessible from this menu. (Find a little more detail about accessing help in the section “Getting a Helping Hand,” later in this chapter.)

				Uncovering the contextual menus

				Contextual menus are common to many programs, and Photoshop Elements is no exception. They’re those little menus that appear when you right-click or Control-click on a Mac with a one-button mouse, offering commands and tools related to whatever area or tool you right-clicked.

				[image: tip_4c.eps] The contextual menus are your solution when you may be in doubt about where to find a command on a menu. You just right-click an item, and a shortcut menu opens. Before you become familiar with Photoshop Elements and struggle to find a menu command, always try to first open a contextual menu and look for the command you want on that menu.

				Because contextual menus provide commands respective to the tool you’re using or the object or location you’re clicking, the menu commands change according to the tool or feature you’re using and where you click at the moment you open a contextual menu. For example, in Figure 1-7, you can see the contextual menu that appears after we create a selection marquee and right-click that marquee in the image window. Notice that the commands are all related to selections.

				[image: newfeature_9__4c.eps] In Figure 1-7, notice the Transform Selection command. Photoshop Elements 9 enables you to modify selections using this command, as we explain in Chapter 7.

				[image: 878729-fg0107.tif]
				Figure 1-7: A contextual menu for selections.

				Using the Tools panel

				Elements provides a good number of panels for different purposes. The one that you’ll find you use most is the Tools panel. In panel hierarchy terms, you typically first click a tool on the Tools panel and then use another panel for additional tool options or use the Options bar (which we describe in the section “Selecting tool options from the Options bar,” later in the chapter) for fine-tuning your tool instruments. More often than not, clicking a tool on the Tools panel is your first step in most editing operations.

				[image: tip_4c.eps] By default, the Tools panel opens as a single row of tools down the left side of the Elements window. You can change the view to a double row of tools by clicking the right-pointing double chevron. Doing so shows all tools when you’re working on smaller computer monitors.

				You can easily access tools in Elements by pressing shortcut keys on your keyboard. For a quick glance at the Tools panel and the keystrokes needed to access the tools, look over Figure 1-8.

				[image: 878729-fg0108.eps]
				Figure 1-8: You access tools by clicking the tool on the Tools panel or typing a keyboard shortcut.

				Notice on the Tools panel that several tools appear with a tiny arrowhead pointing right and downward in the lower-right corner of the tool. Whenever you see this arrowhead, remember that more tools are nested within that tool group. Click a tool with an arrowhead and hold down the mouse button, or for a faster response from Elements, just right-click a tool. The fly-out toolbar that opens, as shown in Figure 1-9, offers you more tool selections within that group.

				To select tools within a tool group by using keystrokes, hold down the Shift key and strike the respective key (as shown in Figure 1-9) to access the tool. Keep the Shift key down and repeatedly press the shortcut key to step through all tools in a given group.

				[image: tip_4c.eps] Whether you have to press the Shift key to select tools is controlled by a preference setting. To change the default setting so that you don’t have to press Shift, choose EditPreferencesGeneral (Adobe Photoshop Elements 9PreferencesGeneral) or press Ctrl+K (Ô+K on the Mac).

				[image: remember_4c.eps] The shortcuts work for you at all times except when you’re typing text with the cursor active inside a text block. Be certain to click the Tools panel to select a tool when you finish editing some text.

				The tools are varied, and you may find that you don’t use all the tools in the Tools panel in your workflow. Rather than describe the tool functions here, we address the tools in the rest of this book as they pertain to the respective Elements tasks.

				[image: 878729-fg0109.eps]
				Figure 1-9: Click and hold the mouse button on a tool that has a tiny arrowhead to open a pop-up toolbar.

				Selecting tool options from the Options bar

				When you click a tool on the Tools panel, the Options bar offers you choices specific to the selected tool. Figure 1-10 shows the options available when you select the Brush tool.

				[image: 878729-fg0110.tif]

				Figure 1-10: The Options bar provides attribute choices for a tool selected on the Tools panel.

				Playing with panels

				Elements provides you with a bunch of panels that contain settings and options used to refine the tools you select on the Tools panel and tasks you perform to edit images. Assume for a moment that you want to let your creative juices loose and create a Picasso-esque painting — something that you can do easily in Photoshop Elements.

				First, click the Brush tool and then click a color on the Color Swatches panel. On a new canvas, begin to paint. When you want to change color, click again on the Color Swatches panel on a different color. This kind of interactivity between the Tools panel and another panel is something you frequently use in Elements.

				You can access panels from either the Panels Bin or the Window menu. Many options on panels are intuitive. To become familiar with various panel options, just poke around a little.

				[image: tip_4c.eps] You can drag panels away from the Panel Bin and scatter them all over the Elements workspace. If you remove panels and want to return to all panels docked in the Panel Bin, click Reset Panels at the top of the Editor window.

				By default, you find the panel buttons for Edit Full (while in Edit Full mode), Create, and Share with the panels expanded, as shown in Figure 1-11.

				[image: 878729-fg0111.tif]
				Figure 1-11: The default view shows panels expanded.

				You can use these panels as we explain in the following list:

				Edit Full: Gain quick access to editing tasks. From a drop-down menu, you can toggle editing modes. While you’re in Edit Full mode, you see the button appearing as Edit Full. Open the drop-down menu and you find Edit Quick and Edit Guided. You can change editing modes by choosing one of the menu commands. If you change to Edit Quick, the tab name likewise changes to Edit Quick.

				Create: Click this button to access options to create photo books, photo collages, and slide shows and also to order prints and greeting cards. Click More Options on the Create panel to access additional creation options.

				Share: Click this button to access options that offer many different ways to share your photos with others. On the Share panel, you find options for creating an online album, sending photos via e-mail attachments, using photo and writing CDs and DVDs of photo collections and slide shows. Clicking More Options on the Share panel offers additional options for sharing photos.

				[image: remember_4c.eps] There are differences between creation and sharing options available on Windows versus the Macintosh. Windows users have more creation and sharing options than Macintosh users. For a complete list of what’s available for each platform, see Chapter 15.

				[image: newfeature_9__4c.eps] Choose WindowPanel Bin (see Figure 1-12) to remove the Panel Bin check mark, and the Panel Bin temporarily hides providing more editing space.

				[image: tip_4c.eps] When the Panel Bin is hidden, choose WindowPanel Bin again to display the panels.

				[image: 878729-fg0112.eps]
				Figure 1-12: When you click panel names, the panels collapse, providing you more space to work in the image window.

				Juggling all your interface options

				With all the settings you can use for any given tool, trying to find the option for the edit you want to make can become downright frustrating. To help simplify the process of using tools and selecting options for the tools, here’s what you might do in your normal workflow:

				1. Select a tool on the Tools panel.

				 Obviously, you need to know what task you want to perform, so selecting the proper tool to complete the task is important to know upfront.

				2. Take a quick look at the Options bar.

				 Before moving to other options, be certain that you look over the choices on the Options bar. If you want to use a tool such as the Brush tool or the Clone Stamp tool, perhaps you want to make a decision about what size brush tip you want to use. This choice is specific to the selected tool and therefore appears as an Options bar choice.

				3. Open a panel for more options.

				 If you want to use the Brush tool to apply some color to an image, for example, after you select the Brush tip on the Options bar, open the Color Swatches panel and select a color.

				4. Open a drop-down menu.

				 Not all tools support a drop-down menu on the Options bar. When you see a down-pointing arrow on a tool, click the arrow to open a menu on which you can find more options for that tool.

				5. Get some help.

				 When you hover your cursor over a tool, you see that tool described in blue text. Click the blue text, and your default Web browser opens, displaying a page on Adobe’s Web site where help information and tips explain how to use the respective tool. You also find blue text on the More menu. The blue text alerts you to help information that can be shown in your Web browser.

				Changing Workspaces

				When you’re in Edit Full mode, which we discuss in preceding sections, you can apply any kind of edits to a picture, improve the picture’s appearance, and apply all that Elements offers you. This mode is the richest editor in Elements, in terms of accessing all features. Because Elements has so many different kinds of editing opportunities, the program offers you other workspace views, tailored to the kinds of tasks people typically want to perform.

				Using Edit Quick mode

				Edit Quick mode is designed to provide you with just those tools that you need to prepare a picture for its intended destination, whether it’s printing, onscreen viewing, or one of the other organizing items. Use this mode to make your pictures look good. You don’t find tools for adding text, painting with brushes, or applying gradients in Edit Quick mode. Rather, what you find is a completely different set of panels for balancing contrast and brightness, lighting, and sharpening, for example. This mode is like having a digital darkroom on your desktop, where you take care of perfecting an image like you would in analog photography darkrooms.

				To enter Edit Quick mode while you’re in Edit Full mode, click the Edit Full button to open the drop-down menu and choose Edit Quick; the view changes, as shown in Figure 1-13.

				[image: 878729-fg0113.tif]

				Figure 1-13: Choose Edit Quick from the drop-down menu.

				Here are several differences between Edit Full mode and Edit Quick mode:

				Completely different sets of panels are docked in the Panels Bin. All the panels in Edit Quick mode are related to adjusting brightness controls, and they’re designed to improve the overall appearance of your pictures. In addition, all the Windows menu commands for accessing panels are grayed out. While you work in Edit Quick mode, Elements insists on limiting your use of panels to just the ones docked in the Panels Bin. Moreover, you can’t undock panels from the Panels Bin by dragging them out, as you can in other modes.

				The Tools panel shrinks. Edit Quick mode offers only these tools on the Tools panel:

				 • Zoom

				 • Hand

				 • Magic Selection Brush

				 • Crop

				 • Red Eye Removal

				 • Whiten Teeth

				 • Make Dull Skies Blue

				 • Black and White — High Contrast

				 None of the other Elements tools are accessible while you work in this mode.

				Multiple viewing options are available. Notice in Figure 1-13 that you see two views of the same image. The Before view on the left displays the unedited image. The After view shows you the results of changes you make with panel options and menu commands. You select different viewing modes from menu choices on the View drop-down menu below the image window.

				If you want to return to Edit Full mode, open the drop-down menu where you see Edit Quick, and choose Edit Full.

				Using creation tools

				To organize your pictures for display in a variety of different ways, begin by clicking the Create button. The panels in the Panels Bin change to support different creation options. Click one of the listed options for making a new creation or click the More Options button to select from additional options. In Figure 1-14, we clicked the Create button to open the creation options.As you can see in Figure 1-14, the Panels Bin changed to reflect options available for many different creation tasks.

				We cover each option available in the various creation panels in greater detail in Chapter 15.

				[image: 878729-fg0114.tif]
				Figure 1-14: Click Create and then choose an option for the type of creation you want to edit.

				Using Options Menus

				Each panel in the Panel Bin and the Project Bin contains an Options menu. Click the icon in the top-right corner in a panel and you find menu commands related to the respective panel. As you travel through Elements 9 in this book, we make reference to various menu selections you need to make to perform different editing tasks. For now, realize that when we refer to a panel’s Options menu, you open the menu by clicking the top-right icon, as shown in Figure 1-15.

				[image: 878729-fg0115.eps]
				Figure 1-15: Click the icon in the top-right corner of a panel to open the Options menu.

				Using the Project Bin

				The Project Bin displays thumbnail views of all your open images. Regardless of whether you work in Edit Full or Edit Quick mode, you can immediately see a small image of all the pictures you have open at one time, as shown in Figure 1-16. You can also see thumbnail views of all the different views you create for a single picture. Find out all the details in the following sections.

				If you want to rearrange the thumbnails in the Project Bin, click and drag horizontally to reorganize the order of the thumbnails.

				Creating different views of an image

				What? Different views of the same picture, you say? Yes, indeed. You might create a new view when you want to zoom in on an area for some precise editing and then want to switch back to a wider view. Here’s how you do it:

				1. Double-click a thumbnail image in the Project Bin.

				 You must have a photo open in Edit Full mode. The photo you double-click in the Project Bin appears in the image window as the active document.

				 2. Choose ViewNew Window for <filename>.

				 Note that <filename> is the name of the file in the image window.

				3. Zoom to the new view.

				 A new view appears for the active document, and you see another thumbnail image added to the Project Bin.

				[image: tip_4c.eps] To zoom quickly, click the Zoom tool and click a few times on the picture in the image window to zoom in to the photo.

				4. Toggle views of the same image.

				 Double-click the original thumbnail to see the opening view; double-click the other thumbnail to see the zoomed view.

				[image: 878729-fg0116.tif]

				Figure 1-16: All open pictures and new views are displayed as thumbnails in the Project Bin.

				Hiding the Project Bin

				The Project Bin takes up a lot of room at the bottom of the image window, and you’re not likely to want it open all the time while editing pictures. You can temporarily hide the Project Bin when you want more room in your Elements workspace for editing photos.

				In Elements 9, the Project Bin behaves very similarly to other panels in the Panels Bin. Click the left-pointing chevrons to collapse the bin (Windows) or double-click the title bar (Mac). When collapsed, the bin appears as a panel button. You can drag the button off to the right side of the screen in the Panel Bin area. To reopen the bin, click the right-pointing chevrons (Windows) or double-click the title bar (Mac).

				Using Bin Actions

				A nice feature in Elements is the Bin Actions menu at the top of the Project Bin (Windows) or the Options menu on the far top right side of the bin (Macintosh). Click Bin Actions (Windows) or open the Options menu (Macintosh) to start a new creation, share photos, print all the files open in the Bin, and save the Bin files as an album.

				To the left of the Bin Actions menu, you can find another feature for viewing files in Elements. The Show Open Files (shown by default) is another drop-down menu that offers two options: the default option to show open files and another choice to show files from the Organizer. Choose Show Files from Organizer to add the files in your Organizer to the Project Bin.

				Retracing Your Steps

				Ever since the Apple Macintosh brought a window-like interface to the masses, the Undo command has been one of the most frequently used menu commands in every program developed. You make a change to your document, and if you don’t like it, you simply choose EditUndo or press the keyboard shortcut Ctrl+Z (Ô+Z on the Macintosh).

				In Elements, your options to undo your work provide you much more than reverting to the last view, as we explain in the following sections.

				Using the Undo History panel

				Elements takes the Undo command to new levels by offering you a panel on which all (well, almost all) your changes in an editing session are recorded and available for undoing at any step in an editing sequence.

				Each edit you make is recorded on the Undo History panel. To open the panel, choose WindowUndo History. Make changes to your document, and each step is recorded on the panel, as you see in Figure 1-17.

				[image: 878729-fg0117.tif]
				Figure 1-17: The Undo History panel.

				[image: tip_4c.eps] If Elements slows down and you’re moving along at a snail’s pace, choose EditClearUndo History or choose Clear Undo History from the panel’s Options menu. Elements flushes all the recorded history and frees up some precious memory that often enables you to work faster. You can also use EditClear Clipboard or EditClearAll to eliminate Clipboard data from memory.

				We said almost all steps are recorded because the number of steps the History panel can record is controlled by a preference setting that tops out at 1,000 steps. If you choose EditPreferences (Windows) or Photoshop ElementsPreferences (Mac) and look at the Performance preferences, as we explain in more depth in Chapter 2, the number of history states (times you can go back in history and undo) defaults to 50. You can change the number to the maximum 1,000, if you like. But realize that the more history states you record, the more memory Elements requires.

				When you want to undo multiple edits, open the Undo History panel and click any item listed on the panel. Elements takes you to that last edit while scrubbing all edits that follow the selected item. If you want to bring back the edits, just click again on any step appearing grayed out on the panel to redo up to that level.

				All your steps are listed on the Undo History panel as long as you remain in Elements and don’t close the file. When the file is closed, all history information is lost.

				Reverting to the last save

				While you work away in Elements, always plan on saving your work regularly. Each time you save in an editing session, the Undo History panel preserves the list of edits you made before the save and up to the maximum number of history states defined in the General preferences.

				If you save, then perform more edits, and then want to return to the last saved version of your document, Elements provides you with a quick, efficient way to do so. If you choose EditRevert, Elements eliminates your new edits and takes you back to the last time you saved your file.

				When you choose Revert, Revert appears in the Undo History panel. You can eliminate the Revert command from the Undo History panel by right-clicking Revert on the Undo History panel and choosing Delete from the context menu that appears. This command returns you to the edits made after the last save.

				Getting a Helping Hand

				You can reach for this book whenever you want some details about accomplishing a task while working in Elements. However, for those little annoying moments, and just in case some coffee stains blot out a few pages in this book, you may want to look for an alternative feature description from another source.

				Rather than accumulate a library of Elements books, all you need to do is look within Elements to find valuable help information quickly and easily. If you’re stuck on understanding a feature, ample help documents are only a mouse click away and can help you overcome some frustrating moments.

				Using Help

				Your first stop in exploring the helpful information Elements provides is on the Help menu. On this menu, you can find several menu commands that offer information:

				Photoshop Elements Help: Choose HelpPhotoshop Elements Help or press the F1 key (Windows) or the Help key (Macintosh) to open the Elements Help file. You can type a search topic and press Enter to open a list of items that provide helpful information about the searched words.

				 For quick access to the Help document, type the text you want to search into the text box on the right side of the menu bar in Edit Full or Edit Quick mode.

				Key Concepts: While you read this book, if we use a term that you don’t completely understand, open the Photoshop Elements Key Concepts. A Web page opens in your default Web browser and provides many Web pages with definitions of terms and concepts.

				Support: This menu command launches your default Web browser and takes you to the Adobe Web site, where you can find information about Elements, problems reported by users, and some work-around methods for getting a job done. You can find additional Web-assisted help information by clicking Photoshop Elements Online and Online Learning Resources. The vast collection of Web pages on Adobe’s Web site offers you assistance, tips and techniques, and solutions to many problems that come with editing images. Be sure to spend some time browsing these Web pages.

				Video Tutorials: Choose HelpVideo Tutorials to open a Web page where videos for common tasks are hosted on Adobe’s Web site.

				Forum: Choose HelpForum to explore user comments and questions with answers to many common problems.

				Using ToolTips

				While you move your cursor around tools and panels, pause a moment before clicking the mouse. A slight delay in your actions produces a ToolTip. Elements provides this sort of dynamic help when you pause the cursor before moving to another location.

			

			
		

	
		
			
			
				Chapter 2

				Getting Ready to Edit

				In This Chapter

				Specifying editing preferences

				Specifying organizing preferences

				Working with presets

				Understanding color in Photoshop Elements

				Setting up your color management system

				Although not as exciting as firing up Elements and working on your precious pictures, customizing Elements for your personal work habits and properly setting up color management is critical to everything else you do in the program. This chapter explains how to take charge of Elements and customize your work environment by adjusting preference settings and setting up a color management system. If you’re new to Elements or image editing in general, you might not know just how you want to set up certain features right away. However, you can always refer to this chapter when you review and update settings and options later, after you become familiar with other features in Elements.

				Controlling the Editing Environment

				Opening Elements for the first time is like moving into a new office. Before you begin work, you need to organize the office. At minimum, you need to set up the desk and computer before you can do anything. In Elements terms, the office organization consists of specifying Preferences settings. Preferences are settings that provide a means to customize your work in Elements and to fine-tune the program according to your personal work habits.

				What we offer in the following sections is a brief description of the preference options available to you. When you need some detail regarding one preference option or another, look at the help documents we discuss in Chapter 1. If you use the help documents as a reference, you won’t need to memorize the vast number of settings Elements provides.

				[image: remember_4c.eps] There are two Preferences dialog boxes. One Preferences dialog box is available in the Edit Full mode workspace, and the other is available in the Organizer workspace. This section covers the Preferences dialog box that you open when in Edit Full mode; it’s common to both Windows and the Macintosh.

				Launching and navigating Preferences

				Preferences, which you can access in Edit Full mode, are all contained in a dialog box that’s organized into nine panes. By default, when you open the Preferences dialog box, you first see the General pane. To open the Preferences dialog box, choose EditPreferencesGeneral. (Or choose Photoshop ElementsPreferencesGeneral on a Macintosh.) Alternatively, press Ctrl+K (Ô+K on a Macintosh). Using either method opens the Preferences dialog box to the General pane, as shown in Figure 2-1.

				[image: 878729-fg0201.tif]

				Figure 2-1: The General pane in the Preferences dialog box.

				In Figure 2-1, you see items on both the left and right sides of the dialog box that are common to all preferences panes. Here’s a quick introduction to what these items are and how they work:

				Panes list: Elements lists all the different panes in the Preferences dialog box along the left side of the dialog box. Click an item in the list to make the respective pane open on the right side of the dialog box. (In earlier versions of Elements, you had a drop-down menu from which you selected the different panes.)

				OK: Click OK to accept any changes made in any pane and dismiss the Preferences dialog box.

				Cancel: Click Cancel to return to the same settings as when you opened a pane and to dismiss the dialog box. If you hold down the Alt (Option on Mac) key, the Cancel button changes to Reset, and clicking that button performs the same action as clicking the Reset button.

				Prev: Switch to the previous pane.

				Next: Switch to the next pane. You can also press Ctrl+(1 through 9 keys) to jump to another pane. Or press Ô+(1 through 9 keys) on a Macintosh.

				Checking out all the preferences panes

				The settings in the Preferences dialog box are organized into different panes that reflect key categories of preferences. The following list briefly describes the types of settings you can adjust in each of the preferences panes:

				General preferences, as the name implies, apply to overall general settings you adjust for your editing environment.

				Saving Files preferences relate to options available for saving files. You can choose to add extensions to filenames, save files with layers or flatten layers when you’re saving a file (as we explain in Chapter 8), save files with image previews that appear when you’re viewing files as icons on your desktop, and save with some compatibility options.

				Performance preferences is the pane where you find history states (explained in Chapter 1) and memory settings, such as scratch disk settings. (See the sidebar “What’s a scratch disk?” in this chapter for more on scratch disks.)

				
				What’s a scratch disk?

				Assume that you have 100 megabytes (MB) of free RAM (your internal computer memory) and you want to work on a picture that consumes 200MB of hard drive space. Elements needs to load all 200MB of the file into RAM. Therefore, an auxiliary source of RAM is needed in order for you to work on the image; Elements uses your hard drive. When a hard drive is used as an extension of RAM, this source is a scratch disk.

				If you have more than one hard drive connected to your computer, you can instruct Elements to use all hard drives, and you can select the order of the hard drives that Elements uses for your extension of RAM. All disks and media sources appear in a list as 1, 2, 3, 4, and so on.

				Warning: Don’t use USB 1.1 external hard drives or other drives that have connections slower than USB 2 or FireWire. Using slower drives slows Elements’ performance.



				Display & Cursors preferences offer options for how certain tool cursors are displayed and how you view the Crop tool when you’re cropping images.

				Transparency preferences require an understanding of how Elements represents transparency. Imagine painting a portrait on a piece of clear acetate. The area you paint is opaque, and the area surrounding the portrait is transparent. To display transparency in Elements, you need some method to represent transparent areas. (Chapter 7 has more details.) Open the Transparency preferences and make choices for how transparency is displayed in your 2-D Elements environment.

				Units & Rulers preferences let you specify settings for ruler units, column guides, and document preset resolutions.

				Grid preferences (Windows) or Guides & Grid (Macintosh) offer options for gridline color, divisions, and subdivisions. A grid shows you nonprinting horizontal and vertical lines. You use a grid to align objects, type, and other elements. You can snap items to the gridlines to make aligning objects much easier. Guidelines can be dragged from the ruler and positioned between guidelines.

				Plug-Ins preferences include options for selecting an additional Plug-Ins folder for storing third-party utilities to work with Elements.

				Type preferences provide options for setting text attributes. You have options for using different quote marks, showing Asian characters, showing font names in English, and previewing font sizes.

				Controlling the Organizing Environment

				[image: remember_4c.eps] A whole different set of Preferences appears when you open the Organizer and choose EditPreferences or press Ctrl+K (Adobe Elements 9 OrganizerPreferences or Ô+K on the Mac). Initially, you may be confused because the dialog box that opens when you work in the Organizer is also named Preferences. However, a quick glance at the dialog box shows you a different set of choices. In the following sections, you can find a brief introduction to the Organizer and discover all the different organization preferences that Elements has to offer.

				[image: tip_4c.eps] When you open the Edit Full or Edit Quick mode and press Ctrl+K (Ô+K on Mac) to open the Preferences dialog box, pressing Ctrl (Ô)+K+0 (zero) opens the Organizer Preferences. After you make a preference adjustment in the Organizer Preferences and click OK — or you click Cancel or press the Esc key to dismiss the dialog box — you’re returned to the Editing mode’s Preferences dialog box.

				Understanding the Photoshop Elements Organizer

				We cover all you need to know about the wonderful Adobe Photoshop Elements Organizer environment in Chapter 6, so we don’t describe in this chapter all that the Organizer offers you. Just be aware that when you’re setting the Organizer preferences, you’re setting preferences for the Organizer only. To take a quick peek at the Organizer, click the Organizer button at the top of the Elements window while in Edit Full or Edit Quick mode.

				Navigating Organizer preferences

				You can open the Organizer Preferences dialog box after opening the Organizer. You can use a keyboard shortcut to open the Organizer Preferences dialog box. Press Ctrl(Ô)+0 (zero) to open the Organizer from within a Preferences dialog box in either editor to gain access to the Organizer Preferences dialog box. Alternatively, you can choose EditPreferences (Windows) or Adobe Elements 9 OrganizerPreferences (Macintosh) or press Ctrl+K (Ô+K on the Macintosh) in the Organizer window to open the Preferences dialog box, shown in Figure 2-2.

				[image: 878729-fg0202.tif]

				Figure 2-2: Choose EditPreferences and select a submenu item to open the Organizer Preferences dialog box shown here.

				The Organizer Preferences dialog box uses the same metaphor to toggle through a number of panes that the Edit Preferences dialog box uses. Click the names in the list on the left side of the dialog box to open the respective panes on the right. At the bottom of the dialog box, you find items that are common to all panes in the Preferences dialog box. These include

				Restore Default Settings: Click Restore Default Settings to change all panes to their original defaults.

				OK: Click OK to accept new changes.

				Cancel: If you click Cancel in any pane, any changes you made aren’t registered.

				Help: Click Help to open the Help window and find information about Organize & Share preferences.

				Setting preferences in all the panes

				With the Organizer Preferences dialog box open, here’s a quick overview of what you find there:

				General: These items affect a miscellaneous group of settings that are applied to files when you’re using the Create tool. Chapter 16 explains this tool in detail. You also find settings for changing the Interface Brightness from Dark to Light.

				Files: Here you find options for managing file data, connecting to missing files, setting prompts to back up your data, saving catalogs, choosing file and folder locations for saved files, rotating images, burning CD/DVDs (Windows-only), and handling preview sizes.

				Folder Location View: These are options for showing files and folders in groups and selected folders.

				Editing: You can enable another application that provides some editing features not found in Elements to edit an image based on its file type. One good example for adding another editor is when you’re editing video clips. If you have Adobe Premiere Elements, you can add Premiere Elements as another editor. If you don’t have Premiere Elements installed, you can use another editor, such as Windows Movie Maker (Windows) or iMovie (Macintosh).

				Camera or Card Reader: Here you can determine how to handle acquiring images from digital cameras and media storage cards. Your computer may have a built-in card reader in which you can insert a media card, such as CompactFlash or Smart Media, or a USB card reader that supports a media card. In other cases, you may have a cable that connects from your camera to a USB port on your computer. Use these preferences with media cards, camera connections, and download options.

				Scanner (Windows): If you scan images with a scanner connected to your computer, the Scanner preferences hold all the options you may want to set.

				Date View: View files that you can add to the pane or from selections for a variety of holiday dates.

				Keyword Tags and Albums: These preferences help you find and sort your images, as we explain in much more detail in Chapters 5 and 6. Tag preferences offer options for sorting tags and icon views for tags.

				Sharing: The options on this preferences pane relate to sharing files via e-mail. Options are available for setting an e-mail client and adding captions to e-mailed files.

				Adobe Partner Services: These preferences offer choices for handling program updates and online service orders. You can choose to check for program updates automatically or manually, choose options for printing and sharing images, and specify how you want to update creations, accounts, and more.

				[image: newfeature_9__4c.eps] Media-Analysis options: Media-Analysis performs automatic analysis of media in a catalog — things like analyzing photos with people in the images. You can turn off Media-Analysis in this pane.

				Backup/Synchronization: You have a choice here to sign in with your Adobe ID account. Once signed in, you can back up photos to your library on Photoshop.com.

				Customizing Presets

				Part of the fun of image editing is choosing brush tips, swatch colors, gradient colors, and patterns to create the look you want. To get you started, Elements provides you with a number of preset libraries that you can load and use at your will. For example, you can load a Brushes library to acquire different brush tips you use with the Brush tool. But you’re likely to want to customize the preset libraries at least a little bit, too.

				You can change libraries individually in respective panels where the items are used. For example, you can change color swatch libraries on the Color Swatches panel or brush tips libraries from Options bar choices. Another way you can change libraries is to use the Preset Manager dialog box, as shown in Figure 2-3.

				[image: 878729-fg0203.tif]
				Figure 2-3: The Preset Manager dialog box provides a central area where you can change libraries.

				We cover using the presets in Chapter 12, which is where you can find out how to use the many different presets that Elements provides. The important thing to note here is that you can change the presets according to your editing needs.

				To open the Preset Manager dialog box, choose EditPreset Manager. The options you have available include

				Learn More About: The Preset Manager: Click the blue Preset Manager hyperlinked text to open the Help document and find out more about managing presets.

				Preset Type: Open the drop-down menu to choose from Brushes, Swatches, Gradients, and Patterns.

				More: The More drop-down menu lists different viewing options. You can view the library items as text lists or as thumbnail views.

				Done: Any changes you make in the Preset Manager are recorded and saved when you click Done.

				Load: Click this button to open another library. Elements provides you with several libraries for each preset type from which to choose.

				Save Set: You can save any changes you make in the Preset Manager as a new library. If you make a change, use this option so that you don’t disturb the original presets.

				Rename: Each item in a library has a unique name. If you want to rename an item, click the thumbnail in the Preview pane, click Rename, and type a new name in the dialog box that appears.

				Delete: Click an item in the Preview window and click Delete to remove the item from the library.

				Getting Familiar with Color

				We could spend a whole lot of time and many pages in this book delving into the complex world of color theory and definitions. You wouldn’t likely read it, and we’re not so inclined to reduce this book from a real page-turner to something that’s likely to sedate you. Rather, in the following sections, we offer some fundamental principles to make your work in Elements easier when you’re editing color images.

				Introducing color channels

				Your first level of understanding color is to understand what RGB is and how it comes about. RGB stands for red, green, and blue. These are the primary colors in the computer world. Forget about what you know about primary colors in an analog world; computers see primary colors as RGB.

				RGB color is divided into color channels. Although you can’t see the individual channels in Elements, you still need to understand just a little about color channels.

				When you see a color pixel (a tiny square), the color is represented as different levels of gray in each channel. This may sound confusing at first, but stay with us for just a minute. When you have a color channel, such as the red channel, and you let all light pass through the channel, you end up with a bright red. If you screen that light a little with a gray filter, you let less light pass through, thereby diluting the red color. This is how channels work. Individually, they all use different levels of gray that permit up to 256 levels of light to pass through them. When you change the intensity of light in the different channels, you ultimately change the color.

				Each channel can have up to 256 levels of gray that mask out light. The total number of possibilities for creating color in an RGB model is achieved by multiplying the values for each channel (256 × 256 × 256). The result is more than 16.7 million; that’s the total number of colors a computer monitor can display in RGB color.

				This is all well and good as far as theory goes, but what does that mean in practicality? Actually, you see some of this information in Elements tools and dialog boxes. As an experiment, open a file in Elements and choose EnhanceAdjust LightingLevels; the dialog box shown in Figure 2-4 opens.

				[image: 878729-fg0204.tif]
				Figure 2-4: Choose EnhanceAdjust LightingLevels to open the Levels dialog box shown here.

				Notice that the Channel drop-down menu shows you Red, Green, and Blue as individual channels, as well as a composite RGB selection. Furthermore, the Output Levels area shows you values ranging from 0 on the left to 255 on the right. Considering that 0 is a number, you have a total of 256 different levels of gray.

				[image: remember_4c.eps] What’s important is that you know that your work in color is related to RGB images that comprise three different channels. There are 256 levels of gray that can let through or hold back light and change brightness values and color. See Chapters 9 and 10 for more on using tools, such as levels, to adjust color in this way.

				Understanding bit depth

				Another important item to understand about channels is bit depth. A bit holds one of two values; one value is for black, the other for white. When you have 256 levels of gray, you’re working with an 8-bit-per-channel image — 8 bits with two possible values each is 28, or 256, possible levels of gray. Multiply 8 bits per channel times 3 channels (the red, green, and blue channels), and you get 24 bits, which is the common bit depth of images you print on your desktop printer.

				Now, take a look at the ImageMode menu. You should see a menu selection that says 8 Bits/Channel. When you open an image in Elements, if this menu command is grayed out as shown in Figure 2-5, you’re working with a 24-bit image, or an image of 8 bits per channel.

				[image: 878729-fg0205.eps]
				Figure 2-5: When you can choose 8 Bits/Channel, your image bit depth is higher than 8 bits per channel.

				What does it mean when you can select the 8 Bits/Channel menu command? You can be certain that your image isn’t an 8-bit-per-channel image. You may be able to select this command because some digital cameras and most low-end, consumer-grade scanners can capture images at higher bit depths. You can scan a photo on a scanner at 16 bits per channel. When you do, you end up with many more levels of gray. When you take a picture with a quality digital camera, you can capture 16-bit-per-channel images, and you end up with a file containing more than 4,000 levels of gray. That’s a lot!

				Now, here’s the catch. All files need to be reduced to 8 bits per channel before you print them because that’s all the information any printer uses. In addition, many tools, commands, and panel options work only with 8-bit-per-channel images. So, you ask, “What’s the benefit of acquiring images at higher bit depths than I can print them?”

				[image: remember_4c.eps] If you attempt to adjust brightness and contrast, or other image enhancements, in an 8-bit-per-channel image, you often destroy some data. You can cause some noticeable image degradation if you move adjustment sliders too far while working with 8-bit-per-channel images. When you edit your 16-bit and 32-bit images, you don’t destroy data — you simply inform Elements which 256 of the total available levels of gray you want to use. The result is an image with more continuous gray tones than you can achieve in 8-bit-per-channel images. (The following section explains how you change an image’s bit depth.)

				To clarify the advantages of working with 16-bit images, take a look at the effects of adjusting photos in 8-bit versus 16-bit modes. In Chapters 9 and 10 we talk about using the Enhance menu commands and, more specifically, using the Levels dialog box to adjust image brightness. Before you jump to those chapters, take a look at the results you get when adjusting a photo using Levels on an 8-bit image and the same adjustment on a 16-bit image.

				Take a look at Figure 2-6. This image is flat and needs a contrast boost. The first edit you need to make in Elements is a Levels adjustment. When you choose EnhanceAdjust LightingLevels or just press Ctrl+L (Ô+L on the Mac), the Levels dialog box opens.

				[image: 878729-fg0206.tif]

				Figure 2-6: An image that needs a contrast adjustment.

				Notice in the Levels dialog box that the histogram shows no data on the far left side of the histogram in Figure 2-7.

				[image: 878729-fg0207.tif]
				Figure 2-7: No data appear on the far left side of the histogram.

				An image with a good tonal range has data across the histogram and appears like a bell shaped graph. To make a Levels adjustment, you simply move the slider below the histogram to the right (in this image) until it appears at the beginning of the data in the graph, as you see in Figure 2-8.

				[image: 878729-fg0208.tif]
				Figure 2-8: Move the left slider to the right to the point where you see the first data in the histogram.

				If you make a similar adjustment, click OK, then reopen the Levels dialog box, you see the histogram appearing similar to what’s shown in Figure 2-9. Notice that the histogram now has gaps along the graph. These gaps indicate that no data are contained in the areas where you see the white lines. In essence, you have experienced data loss.

				[image: 878729-fg0209.tif]
				Figure 2-9: After making a Levels adjustment and reopening the Levels dialog box, you see the histogram appearing with data loss.

				To contrast this adjustment on an 8-bit image with the same adjustment applied to a 16-bit image, look at Figure 2-10. After making the same Levels adjustment and reopening the Levels dialog box you find a much different result. Notice the histogram displays a solid tonal range with no gaps in the graph.

				[image: 878729-fg0210.tif]
				Figure 2-10: When adjusting contrast on 16-bit images, you retain a smooth tonal transition.

				[image: remember_4c.eps] The bottom line in regard to making contrast adjustments in Elements is that you’re always best served by making your edits for brightness and contrast as well as for color correction on 16-bit images compared to 8-bit images.

				Converting 8-bit images to 16-bit images

				If you don’t have a digital camera capable of capturing 16-bit images, are you limited to only working in 8-bit mode? Quite simply, the answer is no. You can convert any image taken in 8-bit mode with a digital camera or a scanner to a full 16-bit image.

				Follow these steps to make the conversion from 8-bit to 16-bit mode:

				1. Open Elements in Edit Full mode.

				 2. Choose FileOpen As. In the Open As dialog box choose Camera Raw from the Open As drop-down menu.

				 3. Click Open Copy in the Camera Raw converter.

				Don’t make any adjustments in the Camera Raw converter, shown in Figure 2-11. As yet, the photo is not a true 16-bit image.

				4. Choose ImageResizeImage Size to open the Image Size dialog box (shown in Figure 2-12).

				 5. Select the the check boxes for Constrain Proportions and Resample Image. Choose Percent from the Width drop down-menu and type 71 in the text box.

				[image: 878729-fg0211.tif]

				Figure 2-11: The Camera Raw converter.

				Both the Width and Height are sized when the Constrain Proportions check boxes are selected as shown in Figure 2-12.

				6. Click OK.

				You now have a true 16-bit image.

				[image: 878729-fg0212.tif]
				Figure 2-12: Resample the image to 71 percent.

				The reason we resampled the image to 71 percent is that we needed to downsample the image 50 percent. By setting the value to 71 you get one half the number of pixels in the resultant image. Don’t worry about the math, just believe us that the end result will be a true 16-bt image. You can compare adjusting Levels on an image before and after following these steps and examine the histograms to see the results.

				Getting Color Right

				In Elements, when it comes to color, the challenge isn’t understanding color theory or definitions, but rather matching the RGB color you see on your computer monitor as closely as possible to your output. Output can be a printout from a color printer or a screen view on a Web page.

				We say match “as closely as possible” because you can’t expect to achieve an exact match. You have far too many printer and monitor variables to deal with. However, if you properly manage color, you can get a very close match.

				To match color between your monitor and your output, you need to first calibrate your monitor and then choose a color workspace profile. In the following sections, you can find all the details.

				Color the easy way

				This section is complex and requires some serious study to follow the descriptions in the upcoming sections. If you’re interested in sharing photos only onscreen (that is, on Web pages, Flickr, Facebook, Twitter, and so on) and you plan to leave the printing to others, you don’t need to bother with color correction and going through a maze of steps to get the color perfected.

				The only consideration you need to make is your overall monitor brightness. If your monitor displays images darker or lighter than other computers viewing your images, then you need to follow the upcoming sections and understand how to adjust your overall monitor brightness.

				If, on the other hand, you adjust brightness and contrast to get a snappy good-looking photo, upload it to Facebook, and the rest of the world sees a reasonable representation of the photo, then skip all the technical stuff following this section. Your monitor is fine, and you’re ready to go.

				Calibrating your monitor

				Your monitor needs to be calibrated to adjust the gamma and brightness, correct any color tints or colorcasts, and generally get your monitor to display, as precisely as possible, accurate colors on your output. You can choose among a few tools to adjust monitor brightness. These tools range from a low-cost hardware device that sells for less than $100 to expensive calibration equipment of $3,000 or more — or you can skip the hardware and use tools provided by Mac OS X or Windows.

				[image: technicalstuff_4c.eps] Gamma is the brightness of midlevel tones in an image. In technical terms, it’s a parameter that describes the shape of the transfer function for one or more stages in an imaging pipeline.

				We skip the high-end costly devices and software utilities that don’t do you any good and suggest that you make, at the very least, one valuable purchase for creating a monitor profile: a hardware profiling system. On the low end, some affordable devices go a long way in helping you adjust your monitor brightness and color balance, with prices ranging from $60 to $100 U.S. The best way to find a device that works for you is to search the Internet to find hardware descriptions, dealers, and costs. You’ll find items such as the ColorVision Spyder2express and Pantone Huey Monitor Color Correction, to name just a few.

				On LCD monitors, you need to adjust the hardware controls to bring your monitor into a match for overall brightness with your photo prints. Be certain to run many test prints and match your prints against your monitor view to make the two as similar as possible.

				You have a lot to focus on to calibrate monitors and get color right on your monitor and your output. We talk more about color output in Chapter 14. For a good resource for color correction and printing using Photoshop Elements, we recommend that you look at Color Management for Digital Photographers For Dummies, by Ted Padova and Don Mason (Wiley).

				Choosing a color workspace

				After you adjust your monitor color by using a hardware profiling system, your next step is to choose your color workspace. In Elements, you have a choice between two workspace colors: either sRGB or Adobe RGB (1998). You access your color workspace settings by choosing EditColor Settings. The Color Settings dialog box opens, as shown in Figure 2-13.

				[image: 878729-fg0213.tif]

				Figure 2-13: The Color Settings dialog box.

				The options you have in the Color Settings dialog box include

				No Color Management: This choice turns off all color management. Don’t choose this option for any work you do in Elements. When using No Color Management, you need to work with files that have color profiles embedded in the photos. Most likely you won’t use these types of photos. For information related to when you might use the No Color Management option, see Chapter 14.

				Always Optimize Colors for Computer Screens: Selecting this radio button sets your workspace to sRGB. sRGB color is used quite often for viewing images on your monitor. But this workspace often results in the best choice for color printing, too. Many color printers can output all the colors you can see in the sRGB workspace. In addition, many photo services, such as the Kodak EasyShare services we talk about in Chapter 16, prefer this workspace color.

				Always Optimize for Printing: Selecting this option sets your color workspace to Adobe RGB (1998). The color in this workspace has more available colors than you can see on your monitor. If you choose this workspace, be certain that your printer is capable of using all the colors in this color space.

				Allow Me to Choose: When you choose this option, Elements prompts you for a profile assignment when you open images that contain no profile. This setting is handy if you work back and forth between screen and print images.

				Understanding how profiles work

				You probably created a monitor color profile when you calibrated your monitor. You probably also selected a color profile when you opened the Color Settings dialog box and selected your workspace color. When you start your computer, your monitor color profile kicks in and adjusts your overall monitor brightness and corrects for any colorcasts. When you open a photo in Elements, color is automatically converted from your monitor color space to your workspace color.

				At print time, you use another color profile to output your photos to your desktop color printer. Color is then converted from your workspace color to your printer’s color space. In Chapter 14, we show you how to use color profiles for printing. For now, just realize that each of these color profiles, and using them properly, determines whether you can get good color output.
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